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Welcome to ONE BILLION RISING, V-Day’s Annual 
Report for 2012 – 2013. 

This year, with your help, we witnessed history in the 
making when one billion people ROSE in unison to 
end violence against women and girls.  For 15 years, 
V-Day activists have shattered taboos, changed  
culture, and funded critical on the ground anti-violence 
work.  This year, they moved the needle so that the 
issue of violence against women and girls will never 
be marginalized again.

In the same way that The Vagina Monologues  
became our guide 15 years ago, One Billion Rising 
has become our mantra, our muse. 

By just saying the phrase ”One Billion Rising”, 
inviting people to say it and understand it, we  
accomplished a key goal of the campaign – showing 
the world how central the issue of violence against 
women and girls is by showing them how many 
women have been affected.

In the end, our team of staff, activists, and supporters 
moved fast and kept true to the mission. We laughed 
and we cried and we kept going with a spirit that 
was beautiful, at times intense, but always meaningful.

Planning for a global day of action that would begin 
in Australia and 48-hours later end in Hawaii was a 
challenge for our social media team who stayed up 
throughout.

On 14 February, activists in 207 countries, more than 
the UN officially recognizes, rose. Women wrote in 
saying that they had never realized they could get 
help until they heard about the campaign, others 
wrote to tell us the details of their risings. Videos and 
pictures flooded in on V-Day’s Facebook page and 
Twitter feed. By the end of the day, Twitter impressions 
were over 500 million and #1billionrising had trended 
in seven countries, including multiple times in the 
U.S. and UK. Media impressions in the U.S. alone 
exceeded 600 million with foreign correspondents 
from CNN, BBC, The Guardian and Reuters among 
the many following the day.

As you will see through this report, when working in 
community, local activists have the power to rise up 
and carve out deeper impact on a global scale. It 
was a breathtaking year, and we hope you enjoy 
reading about it.

 We’re ready for 2014.  Join us and RISE4JUSTICE!

 

Susan Celia Swan 
Executive Director

 

Cecile Lipworth 
Managing Director
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Message from eve

It was the women of Congo who first taught me the 
power of dance. 

For seven years I have had the privilege of working 
side by side with my sisters from the DRC. They are 
rising up and fighting back in the midst of an economic 
war that has been raging for 14 years for the minerals 
of their country. A war that has not only been responsible 
for the death of eight million, but has been fought on the 
bodies of hundreds of thousands of women, where 
systematic rape and torture has been used to occupy 
villages and control the mines. The grotesque atrocities 
women have survived are beyond our capacity to 
receive or comprehend and I wondered for quite 
some time how Congolese women could not only 
continue to live, but continue to live with the huge 
power, energy, grace, and vision they have. Then it 
occurred to me that the women of Congo dance.  
And when they dance they dance with everything. 

It was in the midst of dancing with a group of 200 
survivors in Congo when I suddenly got the power of 
dance to transform, to be dangerous and celebratory 
and disruptive and sexual and joyful. I understood 
that dance can melt the walls of our divisions, dissolve 
class and race, and create solidarity. That it exposes 
our bodies to each other and the world, and that it 
creates a collective energy and freedom that liberates 
ideas and the conviction and courage to make those 
ideas happen.

For 16 years I have spent most of my hours and days 
thinking about violence against women and girls. I 
have traveled to over 70 countries and listened to the 
stories of women in war time and in their every day 
lives. What it has taught me is that violence against 
women is a worldwide epidemic. It is the methodology 
which sustains patriarchy and it is everywhere. It 
may manifest itself differently from culture to culture 
- female genital mutilation in one place, internet 
bullying in another, gang rape here, acid burning 
there - but I believe it is the mother issue of our times.

Sexual predation has become preparation and 
training for all further dominations and occupations 
occurring in the world today. After all, if you can 
seize a woman’s body and take what you want without 
consequence or reciprocity, you can do the same to 
the Earth, you can do the same to countries, peoples, 
workers. You can do the same to anyone or anything.

In the 16 years we have been working, V-Day has 
tried endless approaches to solving this dilemma  
and of course we have had many successes, but we 
have not ended the violence. When we reached our 
15th year we realized we had to go further and 
escalate our efforts. We had to ask how we as a 
global movement could take everything we have 
done and push it to the next level. 

It was there, dancing in Congo, when we realized 
what that next step was, when we imagined what 
would happen if one billion women and all the men 
who loved them danced together on one day and 
released the energy and power that comes through 
our bodies when we move together.  And so we put 
out the call to rise up and DANCE. The result was the 
biggest mass action to end violence against women 
in the history of the world. 

The outcomes were vast and still being documented. 
Many women survivors have written to say they 
reclaimed their bodies, their trust, and the right to 
fully inhabit public space by the protection and 
inspiration of dancing in solidarity. Rising created a 
wave of energy and courage that birthed many 
public forums, panels, teach-ins. We witnessed 
Presidents and members of parliaments, First Ladies, 
the Queen Mother of Bhutan, and religious leaders 
putting their bodies on the line, dancing and deepening 
their commitment to the issue. We saw new coalitions 
formed everywhere across many issues and lines, 
thousands of new people coming into this issue who 
had never spoken up before. 

Older and younger feminists came together. Dancing 
and rising inspired new laws in quite a few places and 
gave many courage and legitimacy to bring cases 
forward.  And there have been victories. One Billion 
Rising brought women forward in unprecedented 
numbers to tell their stories and created a global 
wind that scattered seeds, fertilized ideas, and blew 
open boundaries. 

This year, One Billion Rising for Justice is taking the 
campaign further, deeper, keeping dance at the 
forefront while addressing the most visceral and 
practical need for justice. It is about creating the 
venues and platforms for revealing truths. Exposing 
the lies, the hurts, the desecrations. It is about 
creating just and safe cultures where women are 
encouraged to come forward with their stories 
rather than being blamed or attacked or made to  
feel responsible for what has been done to them.

On 14 February 2014, one billion and more of us will 
shake free this legacy, these shackles, this violence, 
these wounds, and a new energy will rise. And we 
will know justice. Come rise with us.

LOVE,  

Eve Ensler 
Founder/Board Chair 
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V-DAY IS A GLOBAL ACTIVIST MOVEMENT TO END VIOLENCE AGAINST WOMEN AND GIRLS.
Founded by Tony Award winning Playwright Eve Ensler in 1998, V-Day 
became a unique global movement when her play, The Vagina Monologues 
broke ground, offering the world a piece of art like nothing it had seen before.

Ensler has been named one of US News & World Report’s “Best Leaders,” 
one of Newsweek’s “150 Women Who Changed the World” and The 
Guardian’s “100 Most Influential Women.”

V-Day has proven that art has the power to transform thinking and inspire 
people to act. We have seen that lasting social and cultural change is 
spread by ordinary people doing extraordinary things. We respect that 
local women best know what their communities need and can become 
unstoppable leaders. We know that one must look at the intersection of 
race, class, and gender to understand violence against women.

Over the past 15 years, tens of thousands of productions of  
The Vagina Monologues and other V-Day artistic works have been  
produced by volunteer activists in the U.S. and around the world,  
educating millions of people about the reality of violence against  
women and girls, and in 2013 highlighting One Billion Rising.

V-Day rising

To date, the V-Day movement has raised over $100 million; crafted  
international educational, media, and PSA campaigns; reopened  
shelters; and funded thousands of community-based anti-violence  
programs and safe houses in Democratic Republic of Congo, Haiti,  
Kenya, Egypt, and Iraq.

V-Day has received numerous acknowledgements including Worth  
Magazine’s “100 Best Charities”, Marie Claire Magazine’s “Top Ten  
Charities”, and is one of the Top-Rated organizations on Guidestar and 
Charity Navigator.

V-Day dreams of a world in which women and girls will be free to thrive, 
rather than merely survive. With your help, we are making it happen.

What is V-Day?
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Dance is dangerous, joyous, 
sexual, holy, disruptive, 
contagious, it breaks the rules.  
It can happen anywhere, anytime, 
with anyone and everyone, and 
it’s free. Dancing insists we take 
up space, we go there together 
in community. Dance joins us 
and pushes us to go further and 
that is why it’s at the center of 
One Billion Rising. 

Eve Ensler

One Billion Rising  
By Eve Ensler and Tony Stroebel
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The beginning of a new world 
ignited by a new energy.
ONE BILLION RISING was the biggest mass  
global action to end violence against women 
and girls in the history of humankind. 

On 14 February 2013, ONE BILLION  people in 207 countries 
rose and danced, women, men, and children in cities, factories, 
farms, streets, schools, communities, in marketplaces, 
parks, by the sea and on mountain tops, in theatres,  
government halls, plazas – and in rain, snow, and sunshine 
– to unique cultural rhythms and choreography.

The diversity was unprecedented, creating a multi-sectoral engagement 
of people across movements and causes – youth, migrant workers, 
urban poor, LGBTQI, artists, farm workers,  teachers, faith based 
groups, indigenous women, cutting across borders, races, class, 
sexual orientation, ages, and genders.

Grassroots women and communities, some of the most marginalized in 
the world, were at the forefront leading the campaigns, highlighting the 
anti-violence work of amazing local women’s groups.

Bridging the divide, the campaign brought to the surface the intersection 
of issues both causing and affecting violence against women - patriarchy, 
imperialism, economic injustice, environmental plunder, religion, 
militarization, intervention of outside countries, immigration, nationalization 
and privatization, and political repression.

Though art and activism, One Billion Rising engaged masses on  
a deeper level, while highlighting the importance of DANCE as both  
a personal and collective action. The campaign created solidarity  
and safe and free spaces where violated women could tell their  
stories, many for the first time – and dance to heal their trauma.

If a billion people rise to dance, 
they will get to that place that 
is our birthright – which is the 
feeling that we generate in 
ourselves of love. People think 
that the most important thing is 
being loved by other people – it 
isn’t. What is important is the 
self-generating of love that you 
get yourself. And that is what 
DANCE gives you – and then 
you share it – you send it out 
across the planet and up into 
the stars.

15-YEAR ANNIVERSARY: ONE BILLION RISING

Alice Walker
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Eve spent the rising with thousands of activists in CONGO

Over 200 flash mobs and dance parties took 
place in more than 120 cities in ITALY 

In the U.S. – major events took place in San Francisco, Los 
Angeles, New York, Atlanta, and countless cities and towns – 
with thousands of groups leading the risings – together with 
celebrities, singers, DJ’s, and political figures

In SOUTH AFRICA V-Girls rose in Soweto and other places, 
creating a beautiful dance video – with flash mobs taking place  
in several cities

Cities and villages 
rose with colorful 
and creative events, 
dances, marches, 
and rallies across 
INDIA – with 
network groups  
mobilizing hundreds 
of thousands of 
people across the 
region Aboriginal women in AUSTRALIA hosted a  

“Rites of Passage to a Violent Free Life” event

NEPAL went 
Gangnam style 
when a flash mob 
took over Patan 
Durban Square

The Skirts Up Movement and Beintuitive 
raised their skirts to denounce an end to 
violence against women and girls in Spain 
and around the world

Dancing parades by 
a network of 

organizations along 
the river in Sarajevo, 

BOSNIA &  
HERZEGOVINA

Highlights of Risings Around The World 
There were tens of thousands of events across the world,  
some key highlights included:

A Night of Devotion 
to honor the Mother 

and the feminine 
represented the  

rising in INDONESIA

In the U.K.- a lead up event called “London Rising” featuring well 
known artists and musicians became the prelude for 220 risings 
that took place around the country

MEXICO rose with countless performance  
events and flashmobs around the country

The next day, ending violence 
against women was on the lips 
of every person in Mexico.

Andrés Naime, Global 
Coordinator for Mexico

National leaders of Gabriela and leaders 
of Gabriela’s sectoral organizations, lead 
the One Billion Rising Philippines 
campaign inspiring activists on all 7,000 
islands to Rise.
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The European Parliament Rose in BELGIUM

Live performances, marches, and rallies 
were held throughout CANADA

Over 300 cities rose in GERMANY and thousands danced in public squares

In AFGHANISTAN a huge march  
took place in Kabul

Women met in homes in SOMALIA to learn 
the flash mob. A march and rally took 
place in the city’s public courtyard, the 
first of its kind....and activists worked 
closely with traffic commissioners to 
ensure a ‘safe’ road to march down

Activism in art 
events and  
demonstrations 
were held in 
IRELAND

Highlights of Risings Around The World 

The City of Lima in 
PERU held events 

throughout the city 
– in campuses, 

plazas, and women’s 
prisons – with TV 

spots airing every 
30 minutes on the 

biggest network

In HUNGARY flash mobs 
and public events were held 
throughout the country

64 districts in BANGLADESH organized 
flash mobs, V-Men workshops, 
concerts, and theatre performances

9th and 10th graders in 
Caracas, VENEZUELA 
rose and danced

KENYA  rose with a main event in 
Nairobi with dozens of organizations 
leading – and with singing and 
dancing in Central Park

SAN MARTINO, 
ITALY held a hula 
hoop flash mob in 
the piazza

Paul Hawken Renowned  
Environmentalist & Author of Blessed Unrest

One Billion Rising is a joyous recognition of the 
sacred and how it must never be made profane by 
any person, institution or government. Violence and 
the oppression of women is the core wound that 
foreshadows all other problems in the world, from 
poverty to war to destruction of the environment. 
Rising is not only dance, it is the birth of the future.  
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15 YEARS AND RISING
What began as one event in New York City in 1998,  
today includes 10,000 + V-Day and One Billion Rising  
events around the globe.
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How We Got One Billion To Rise:  
The Power Of Global Solidarity

Global Coordinators
V-Day engaged over 40 anti-violence leaders  
spanning the globe as Global Coordinators. They 
organized One Billion Rising in their respective 
countries and regions, bringing together their extensive 
networks, groups and alliances – and linking the 
campaign across continents through common issues 
and goals. Coordinators conducted outreach and 
education programs on violence against women 
issues in their own cultural, social, and political 
contexts, translated materials and the campaign 
toolkit into regional languages, fundraised for their 
events, invited local celebrities, government officials, 
artists, writers, educators, and high profile women 
and men to be part of their local campaigns, and 
utilized their connections to build extensive mass 
media campaigns.

One Billion Rising Coordinators galvanized their 
communities and countries in: Bangladesh, Bosnia 
(former Yugoslavia), Brussels (European Women’s 
Lobby), Canada, Croatia, France, The Gambia,  
Germany, Italy, Mexico, Pakistan, Peru, The Philippines, 
South Africa, South Asia (India, Nepal, Afghanistan, 
Sri Lanka, Maldives), Spain, Somalia, Sudan, United 
Kingdom, United States (Atlanta, California, Chicago, 
DC, New York) and Zimbabwe.

Monique Wilson, Global Coordinator for The Philippines

Kamla Bhasin,  
Global Coordinator for South Asia 

One Billion Rising is a new struggle for freedom – 
freedom from patriarchal mindsets, patriarchal 
families, and patriarchal religious traditions.
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High Profile Support

Anne Hathaway,  
Jane Fonda and Marisa Tomei 
 

Actors and V-Day board members Jane Fonda, 
Rosario Dawson, Donna Karan, Thandie Newton, 
Charlize Theron, and Kerry Washington along with 
Jessica Alba, BETTY, Connie Britton, Brandi Carlile, 
Kate Clinton, Glenn Close, Jason Day, Francesca 
Eastwood, Frances Fisher, Jarvis Green, Anne 
Hathaway, Bianca Jagger, Zoe Kravitz, Dylan  
McDermott, Kathy Najimy, Yoko Ono, Apollo Poetry, 
Robert Redford, Anoushka Shankar, Vandana Shiva, 
Sookee, KaDee Strickland, Marisa Tomei, Mario 
Testino, Lily Tomlin, Ruby Wax, Royce White,  
Monique Wilson, Rosie Huntington-Whitely, and 
many more, activated their networks, attended One 
Billion Rising events, amplified the message across 
their social media channels, and rose on 14 February.

Charlize Theron Sookee

Glenn Close

Kerry Washington

Rosario Dawson 

Speak up about violence. It’s one of those things that 
we need to not stay quiet about. If you know some-
thing about someone or have a story to tell, tell it, 
because it gives courage to somebody else. I am 
rising for the amazing women in my country, who are 
together calling and saying enough is enough. I’m 
rising for the child in me who I don’t think will ever 
recover from what happened to her.

Thandie Newton 

It’s part of my life. It’s like breathing. Once you  
know about the plight of fellow human beings and 
there’s something you can do – it’s a vocation that 
keeps me up at night. One in every three women will 
experience violence in their lifetime. Once you know 
that, you want to do something about it. You just look 
at the world in a different way, and you want to 
improve the world for your children and for your 
children’s children.

Alice Walker

Anoushka Shankar 

18          19



11 Alive > 16 Days of Activism - Rutgers Center for Women’s Global Leadership > 1736 Family Crisis Center > 180 Turning Lives Around > 1in9 Campaign > 2000 Roses Foundation > 20th Judicial Circuit Family Violence Coordinating Council > 3 Colours > 3 Manuelas > 416 Community Support For Women > 5 Rhythyms > 50 Cents Period > A Woman’s Place of Merced County > A Better Way Services, Inc. > A Call For Help > A New Day > A New Leaf > A Safe Place > A Safe Place: Domestic Violence Prevention > A Window Between Worlds > A 
Woman’s Fund > A Woman’s Place > A Woman’s Place of Merced County > A Woman’s Touch in Healthcare > A Women’s Place > A.D.A.L.E.A > A.L.I.V.E. (Alternatives to Living in Violent Environments) > A.M.I > A.P.A.F.E.D > A.W.A.R.E. (Aiding Women in Abuse and Rape Emergencies) > AACI Asian Women’s Home > Aama Milan Kendra > AATWIN > ABA Scholarship > ABACO > Abby’s House > Abby’s House Center for Women and Families > ABC > ABC Carpet & Home > ABC Foundation > Aberdeen Womens Aid > Aberdeen Womens’ 
Centre > Error! Hyperlink reference not valid. > Aboriginal Family Violence Prevention and Legal Service > Abri Cotier-Urgences femmes > Abriendo Oportunidades > Abriendo Puertas > Abuse Counseling & Treatment, Inc. > Abused Women’s Advocacy Project > Ac Talentos > ACCESS (Assault Care Center Extending Shelter & Support) > Access York/ Vicitim’s Assistance Center > ACCIONAR ENTRE MUJERES - GUYUNUSAS > ACCORD Corporation > Accueil Femmes Solidarite > ACE A3 > ACLU > ACT Domestic Violence Crisis Service > 
Action Aid India > Action Aid Rwanda > Action for Children in Conflict - Kenya program > Action Innocence > Action Today for Brighter Tomorrows > ACTS Turning Points > Ada Family Crisis Center > Adair County Victim Support Services > AdComm > Addis Tesfa Ena raey lesetoch digaf Mahiber (ATRLDM) > Adelaide House - YWCA Durham > Adelante Familia > Aden Business School > ADEW > ADIBS > ADV & SAS > Advance Advocacy Project > Advice Desk for the Abused > Advocacy & Support Center > Advocacy Center > Advocacy 
Center of Ithaca > Advocacy Center of Syracuse University > Advocacy Forum > Advocacy Program, Women’s Contact Society > Advocacy Services for Abused Deaf VIctims (ASADV) > Advocate Safehouse Project > Advocates Against Family Violence > Advocates Building Peaceful Communities > Advocates for Family Peace > Advocates for Survivors of Domestic Violence > Advocates for Women > Advocates of Ozaukee > Advocates To End Domestic Violence > ADWAS > AFASDA > Afghan Civil Society Forum > Afghan Women Coalition 
Against Corruption > Afghan Women Service and Education (AWSE) > Afghan Women’s Education Centre (AWEC) > Afghan Women’s Fund > Afghan Women’s Journalist Association > Afghan Women’s Resource Centre > Afghan Women’s Skills Development Centre (AWSDC) > Afghanistan-Delaware Communities Together, Inc. > Afghanistan Independent Human Rights Commission (AIHRC) > Afghanistan Institute for Learning (AIL) > AFL-CIO > The Africa Craft Trust > Afro Brazilian Cultural Center of New Jersey > AGEHB - Animation et 
Gestion de l’emploi et l’hbergement en Brest > AGEHB - Animation et Gestion de l’emploi et l’hbergement en Bretagne > Agents of Change Network > Agfas Foyer Pour Femmes d’Ales > Agnes Home > Agnes Home of Jamestown > Agnes Scott College > Agribusiness Systems International - India > AIAS > Aid to Victims of Domestic Abuse (AVDA) > AIDOS > AIDS Committee of Durham > Aids Online > AIDS Project Worcester- women’s HEALTH Project > Aile Ici Siddete Son > Ain O Shalish Kendro > Akili Dada > Akinadada Cervical Cancer 
Trust > Akron Battered Women’s Shelter > Akshara > Akwesasne Family Violence Program > Alabama Coalition Against Rape > Alabama State University > Albany County SAFE Project > Albany Law Clinic and Justice Center, Family Violence Litigation Clinic > Albion Fellows Bacon Center > Alexandria Office on Women Domestic Violence Program > Alianza Dominicana, Project F.A.I.T.H. > Alice Housing > Alice Paul House > Alice Springs Womens Shelter > Alison McAteer House/Centre For Northern Families > All African Women’s Group 
> All Nepal Peasants’ Federation > All Nepal Women’s Association > All Pakistan Bhatta Mazdoor Union > All Pakistan Trade Unions Organisation (APTUDO) > All Womens House > Allen Women’s Resource Center > Alliance Against Domestic Abuse > Alliance Against Family Violence and Sexual Assault > Alliance for Community Trust/Greenville Sexual Trauma Center > Alliance for Girls > Alliance for Sexual Assault Survivors (UCI ASAS) > Alma Center > Alma de Mujer > Alpha House of Tampa Bay > Alpha Womens Center > Alternative 
Horizons > Alternative House > Alternative to Violence of the Palouse > Alternatives for Battered Women > Alternatives For Girls > Alternatives to Domestic Violence > Alternatives to Family Violence > Alternatives to Living In Violent Environments A.L.I.V.E. > Alternatives To Violence > Alternatives to Violence In the Palouse > Alternitives for Girls: The Street Outreach Program > Alvin Ailey Dance Company > Amahoro “What Better Looks Like” campaign > AMAL Human Development Network > Amamantar > AMASOL (Asociacion de Madres 
Solas) > Amazing Woman Foundation > Amcham > Amdelar > Amelia Rising Sexual Assault Centre > AMEND > American Dance Therapy Association > American Federation of Government Employees (AFGE) > American University > AMES (Asociacion de Mujeres en Salud) > Amethyst Inc. > Amigas Latinas > Amigas Unidas > Amigos de las Mujeres > Amnesty International Fredericton Chapter > Amnesty International Group 149 > Amnesty International Japan > Amnesty International South Africa > Amnesty Interntional Souther Region > 
Amnesty International UK “Stop Violence Against Women” > Amnesty International USA > Amy’s House for Women > Anawim Aboriginal Women’s Refuge > Anduhyaun Residence for Native Women > Angela’s House > Angelheart Children’s Shelter > Anhad > ANIMA Kotor, Montenegro > Anjuman Muzreen Punjab > Anna Bixby Women’s Center > Anna Marie’s Alliance > Anna Ogden Hall > Anna’s House > Anne’s Home > Annie’s House > Anselma House > Antigonish Women’s Resource Centre and Sexual Assault Services Association > 
Anti-Violence Project-Long Island > Anynna Nari Kallyan Samity > Apex Police Department > API Domestic Violence Resource Project > Apis of Merida Mexico > Apna Ghar > ARCC > ARCHIsquad Zagreb > Arenas y Esteras > ARFOG > Arizona Coalition Against Domestic Violence > Arizona League to End Regional Trafficking (ALERT) > Arizona Sexual Assault Network > Arlington’s Women’s Shelter > Art Matters Society > Art of Yoga Project > Arte Por La Paz > Arte Sana > Artemis Center for Alternatives to Domestic Violence > Artemis 
House of Spearfish > Artemisia Centro Anti Violenza > Arthur Blank Family Foundation > AS Women’s Center > ASHA - Alternative Solutions for Healing Abuse > Error! Hyperlink reference not valid. > Ashe Cultural Arts Center > Ashera Project > ASI Women’s Center > Asia Foundation’s Women’s Advancement Fund > Asian & Pacific Islander Women & Family Safety Center > Asian Americans for Community Involvement > Asian Human Rights > Asian Legal Resource Centre - Women’s International Shared Experience Project > Asian 
Women’s Home > Asian Womens Human Rights Coalition > Ask Wellness (shop program) > Asmita > Asociacion Antiviolencia Arte por la Paz > Asociacion de Educacion Multidisciplinaria > Asociacion de Gerentes de Guatemala > Asociacion de Mujeres en Salud > Asociacion de Mujeres y Amas de Casa de Rincon de Soto > Asociacion en Pro del Derecho a la Identidad en la Ninez y Adolescencia > Asociacion Hogar Nuevos Horizontes > Asociacion IDEI > Asociacion Liberanza > Asociacion para la Integracion de las Culturas -Pandora 
> Asociacion Por Ti Mujer > Asociacion PRO Bienestar de la Familia Guatemalteca > Asociacion Venezolana de Mujeres (ASVEMU) > Asofarma > Asosiacion de Azucareros de Guatemala > ASPEN > Assault Prevention Theatre > Assault Response & Care Centre > Assault Vicitm Services > Assaulted Women’s Helpline > Assessment and Resource Center > Associacao ComuniDaria > Associacion Asistencia Dones Agredidas Sexualment > Association “Les yeux ouverts” Vannes > Association Against Violent Communication > Association 
Concerning Sexual Violence Against Women > Association des Victimes, Parents et Amis du 28 Septembre 2009 (AVIPA) > Association Mere et Enfant de GuinÃƒÂ©e > Association of Rape Crisis in Israel: Crisis Center for Religious Women > Association of Roma Women ESMA, Skopje, Macedonia > Associazione Centro Antiviolenza > Associazione La Ceiba > Associazione Modena Terzo Mondo > Associazione Nazionale Volontarie del Telefono Rosa > Associazione No.Di > Associazione Nondasola > Assualt Prevention Shuttle > ATASK 
(Asian Task Force Against Domestic Violence) > Astha Sansthan > Atlanta Ballet > Atlanta Women’s Foundation > Atlantic County Women’s Center > AU Women’s Center > Auberge Madeleine > Augusta Sexual Assault and Crises Support Center > Augustana Women’s Association > Auroville International Township > Austin-Safeplace > Authentic Beauty > Autonomna Zenska Kuca Zagreb > Autonomni Zenski Centar Beograd > Autumn House > Avalon > Avalon Sexual Assault Centre > Avalon Women’s Shelter > AVDA > Avery County Against 
Domestic Abuse > AVIVA - Berlin > AVON > Avon Walk for Breast Cancer > AWARE > AWARE in Hardwick > AWARE Shelter > AWARE Singapore > AWCCA Emergency Fund > AWO Bremen Frauen Haus > Awotaan Family Healing Lodge (Formerly Calgary Native Womens Shelter) > Ayuda, Inc. > Azad Foundation > B.A.R.N. > B.O.B. > Babson and Olin Colleges > Babyland Family Services, Inc. > Bahay Pag-asa > Baldwin Wallace University > Error! Hyperlink reference not valid. > Banco Inmobiliario > Bandana Rana > Bangladesh Action 
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ORGANIZATIONS THAT ROSE
TENS OF THOUSANDS OF ORGANIZATIONS AND GROUPS JOINED  
IN SOLIDARITY ACROSS THE PLANET, INCLUDING SOCIAL JUSTICE  
ACTIVISTS, FAITH ORGANIZATIONS, FARMWORKERS, UNIONS,  
SCHOOLS, MINEWORKERS, MILITARY SERVICE WOMEN, NOBEL  
WINNERS, FILMMAKERS, ARTISTS, DANCERS, MUSICIANS,  
PARLIAMENTARIANS, AND LEGISLATORS.
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Covering the Story: What the Media Said

Social Media
On 14 February, 2013 – One Billion Rising trended on 
TWITTER in seven countries: the Philippines, India, 
South Africa, United Kingdom, Mexico, Peru, and 
four times in the United States.

One Billion Rising received 577,714,090 impressions 
on Twitter alone over 48 hours.

Over 10,000 user generated images were submitted 
through Twitter and INSTAGRAM.

FACEBOOK pages for One Billion Rising were created 
in over 100 countries.

On YOUTUBE, V-Day’s series of campaign videos 
went viral beginning in September with the One Billion 
Rising short film which has logged over one million 
views on YouTube, and in November, the One Billion 
Rising anthem music video “Break The Chain” was 
released; by 14 February, it had over 900,000 views.

Through LIVESTREAM, One Billion Rising events 
were seen on onebillionrising.org on every continent 
except Antarctica (believe us, we tried), including 
Manila, New Delhi, Johannesburg, Banjul, Bukavu, 
Belgrade, Frome, Berne, San Remo, Atlanta, Chicago, 
Toronto, Hawaii, Miami, New York City, San Francisco, 
and many more.

We received more than 10,000 photos on Facebook, 
Twitter, and Instagram in the 48 hours spanning 13 
and 14 February. 

By the end of the campaign, we had increased our 
social footprint by over 1,000%, achieved over a 
BILLION IMPRESSIONS across mostly owned and 
earned media, and engaged a global network of 
supporters on a massive scale. Thanks to the power of 
social media, the conversation continues online today.

One Billion Rising won the “Just Cause” SoMe 
Award in Portland for “best use of social media  
to raise awareness and/or solicit donations for a 
cause or a non-profit organization.”  

In The News
The campaign was covered by media in all corners 
of world from The New York Times to The Times of 
India; from Somali television to the BBC World 
Service; from regional papers in Nebraska to National 
Public Radio; from The Christian Science Monitor to 
The Guardian live blog covering the day’s events. 
Reuters, the BBC, CNN iReport, and The Guardian, 
had their correspondents worldwide on alert to 
cover One Billion Rising events. Wire services 
covered the story including The Associated Press, 
Reuters, Agence France Presse, and more.

In the lead-up to 14 February, Eve appeared on 
dozens of media programs and completed interviews 
and press conferences around the globe. One week 
before, Eve participated in a global telepress confer-
ence from City of Joy in the Democratic Republic of 
Congo with over 40 international journalists.

V-Day Board members and high profile supporters 
appeared on major national and international television 
programs to promote the campaign, including: Anne 
Hathaway on “The Tonight Show” during which she 
danced with host Jay Leno and audience members; 
Jane Fonda on “Piers Morgan”; Rosario Dawson on 
“Lawrence O’Donnell”; Thandie Newton on “BBC 
Channel 4” and “CNN International,” and Laura 
Flanders on “Democracy Now,” “Up with Chris 
Hayes,” and“Melissa Harris Perry.”

CNN.COM  
iReport

I left New York City’s Washington Square Park yesterday 
after a One Billion Rising flash mob event with the 
oddest sense of female empowerment. Why odd? 
Well, mostly because I’m a man. Nonetheless, I 
found the spectacle and high-energy performance 
of nearly 300 women dancing to the strains of Tena 
Clark’s Break the Chain tremendously inspiring.

The day of foot- stomping, flash-mobbing and  
booty- shaking all across the world will not, in fact, 
end violence against women. It won’t stop men of  
the cloth from molesting children, the Taliban from 
shooting little girls who want an education, or  
boyfriends from raping their girlfriends. But what it 
does is help all of us tell a new story about what’s 
possible. It creates connections across demographic 
and organisational difference, a shared experience 
and set of memories, an undeniable visual and 
visceral demonstration of our collective outrage. It 
gives us somewhere to place our intolerance for what 
happened in New Delhi and Steubenville and so many 
places just like it that never made the headlines.

Above all else, it awakens our own dormant audacity. 
If Eve Ensler and V-Day can get one billion people  
to dance together, what else might be possible?

Al Jazeera, Courtney Martin

The Guardian

As an idea, One Billion Rising appears to have  
united long-term campaigners with a younger  
generation inspired by the power of social media  
and a desire for change.

In nearly 200 countries around the world, people 
took to the streets Thursday with a carnival spirit as 
part of One Billion Rising, a campaign initiated by 
Eve Ensler, the author of The Vagina Monologues,  
to highlight violence against women. In India, the 
message mirrored widespread public sentiment that 
has swelled after the gang rape and death of a 
23-year-old physiotherapy student in Delhi in  
December, bringing women’s rights and safety to 
the center stage of civic and political discourse. 
...Thursday’s event, which was attended by dozens 
of young people from Delhi University and student 
organizations, seemed to herald a broader movement, 
one focused on changing societal mindsets and 
individual attitudes rather than railing against the 
government.

International Herald Tribune/NYT India

 577,714,090
twitter impressions OVER 48 HOURS

 10,000+
user generated images

TRENDED ON TWITTER IN 
7 COUNTRIES

621,000,000
MEDIA IMPRESSIONS IN THE U.S. ALONE 
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Special Events 
IN ADDITION TO PRODUCING ONE BILLION RISING EVENTS THAT TOOK PLACE ON 14 FEBRUARY IN NEW YORK 
CITY, SAN FRANCISCO, LOS ANGELES, AND SANTA FE, V-DAY ALSO CREATED AND TOOK PART IN MULTIPLE  
LARGE-SCALE EVENTS LEADING UP TO AND FOLLOWING ONE BILLION RISING, INCLUDING:

Africa Rising
In August, 48 activists and social entrepreneurs from 
18 countries in Africa gathered in Nairobi for the first 
ever V-Africa Summit, Africa Rising. The gathering 
was an opportunity for V-Day activists to meet and 
learn from one another, establish a regional and 
continent-wide agenda, and create a platform from 
which to communicate about their work and demands 
to the international community. The summit also 
created great momentum for One Billion Rising and 
was an opportunity for Dr. Denis Mukwege, the  
godfather of the V-Men’s movement, to put out a call 
to men across Africa to create a vision to rise to end 
violence against women.

The summit was an important moment in V-Day’s 
history, not only because it brought together so many 
V-activists from across the region in one place for 
the first time ever, but because it set the stage for 
deeper engagement in V-Day on a grassroots level 
across the continent. Special thanks to the Wallace 
Foundation and Skoll Foundation for making Africa 
Rising possible.

TEDxWomen
In November, Eve hosted and 
curated a special session at 
TEDxWomen called “The Rising,” 
featuring comedian Kate Clinton, 
spoken word artist Asali DeVan 
Ecclesiastes, GAMCOTRAP  
Executive Director Isatou Touray, 
scholar and advocate Meggan 
Watterson, photographer iO Tillett 
Wright, and the singers of the 
Break The Chain anthem. The 
event was produced by V-Board 
member and President & CEO of 
the Paley Center for Media Pat 
Mitchell in partnership with the 
United States Institute of Peace. 
The special “Rising” session 
brought the sold out crowed to 
their feet and sparked numerous 
One Billion Rising events in the 
Washington DC area on 14 February.

State of Female America
In November, V-Day produced a 
special panel discussion at The 
Cooper Union, The State Of Female 
America, moderated by GRITtv’s 
Laura Flanders and featuring Eve, 
Karen Higgins from National 
Nurses United, V-Board member 
Kimberle Crenshaw from UCLA 
School of Law, Amber Hollibaugh 
from Queers for Racial & Economic 
Justice, Ai-jen Poo Director of the 
National Domestic Workers 
Alliance, and Randi Weingarten, 
President of the American Federation 
of Teachers. The evening focused 
on how inequality and public 
policy affect violence against 
women, and celebrated those who 
work towards systemic change.

Breaking The Male Code: After 
Steubenville, A Call To Action 
In March, V-Day hosted this 
sold-out event in collaboration 
with The Nation. Breaking The 
Male Code was a powerful  
and timely panel discussion  
about violence, masculinity, and 
transformation, featuring NoVo 
Foundation Co-Chair Peter Buffett, 
journalist Jimmie Briggs, President 
of Coach for America and former 
football player Joe Ehrmann, A 
Call to Men Co-Founder Tony 
Porter, and Sports Editor at The 
Nation, Dave Zirin. 

Eve World Tour
Eve embarked on a world tour during the ramp up to 
14 February, travelling to Australia, Congo, Mexico, 
Guatemala, Peru, Philippines, India, Bangladesh, 
Belgium, France, Kenya, the United States, and the 
UK, helping to raise enthusiasm and media buzz for 
the campaign in cities and rural areas alike.

Dr. Isatou Touray,  
Executive Director  
of GAMCOTRAP

The V-Africa summit made it 
possible for women and girls to 
realize how solidarity and unity of 
purpose can bring political gains 
for women. Our power in numbers 
and support for each other will 
enable us to impose political will on 
leaders to end the sexual atrocities 
vetted on women and girls.
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After the Rising

One Billion Rising Gave Birth To A Global Solidarity
Reigniting unanimity between women’s organizations 
in various countries and rekindling the ethos of  
sisterhood amongst women on a global scale. It  
became a venue to show strong cohesion among 
women and men around the globe – allowing national 
and international barriers to fade away. It mobilized  
creative energy across all nations – linking artists, 
women’s groups, young people, grassroots women, 
legislators, writers, activists – and where artistic  
and creative initiatives were born.

Impact 
Governments, politicians, and renowned figures from 
around the world, including His Holiness the Dalai 
Lama, First Lady of Nepal, the Mayor of Lima, the 
Prime Minister of Australia, the President of Croatia, 
UN Secretary-General Ban Ki-moon, the Los Angeles 
City Council, British MP Stella Creasy, Vice President 
of the European Parliament Isabelle Durant  
(Belgium), Philadelphia Mayor Michael Nutter, and  
San Francisco Mayor Ed Lee joined the campaign.

One Billion Rising galvanized and empowered  
legislators to generate legislation in support of 
ending violence against women – and demanding 
that pro- women legislation be the priority of  
governments and international councils – from 
VAWA in the United States, to the introduction of 
legislation for national sex education in schools in 
the UK, to protesting national policies that allow 
local and foreign militarization that affect women in 
the Philippines, to the European Parliament voting  
on the resolution on “Elimination and Prevention of 
all forms of Violence Against Women and Girls.”

Isabelle Durant, Belgium,  
Vice President of the European Parliament 

Gregory Floyd, President of Teamsters Local 237

Michael Nutter, Mayor of Philadelphia

Michelle Bachelet, Former President of Chile

Jan Schakowsky, U.S. Representative

One Billion Rising 2013 was the beginning of the new 
world ignited by a new energy. It was not the end of  
a struggle but the escalation of it. One Billion Rising 
became the world’s defiant and celebratory collective 
response to demand an end to violence against women.

We don’t have to accept that 
violence against women is part 
and parcel of life. We can change 
these things. That’s why we’re 
voting in parliament next week to 
make sure that sex and relationship 
education is mandatory for all 
young people, so that we start 
changing ideas and changing 
cultures about what is acceptable 
in a relationship.

Stella Creasy, British MP
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The heart and soul of V-Day – its college and community activists – 
ushered in V-Day’s 15th season with great enthusiasm. Through over 5,400 
V-Day events in over 2,280 locations, V-Day activists in all 50 United 
States, Puerto Rico and 67 countries brought The Vagina Monologues, 
A Memory, A Monologue, A Rant and A Prayer, Any One Of Us: Words 
From Prison, and screenings of V-Day’s documentaries Until The Violence 
Stops and What I Want My Words To Do To You into their communities. 

V-Day benefits raised $2.3 million for local anti-violence groups, including 
over $203,000 for V-Day’s Spotlight Campaign, which for this year 
supported One Billion Rising.

This was V-Day’s most geographically diverse year to date. Some 
notable places around the globe where V-Day activists brought our 
work include: Bolivia; Lady Shri Ram College for Women, New Delhi, 
India; Arabic, English, and Hindi productions at Yale Divinity School; 
Doha, Qatar; Nicosia, Cypress; Okinawa, Japan; Turku, Finland; Ambato, 
Ecuador; Ulaanbaatar, Mongolia; Moscow, Russia; Maori production in 
Auckland, New Zealand; Productions in three different Iranian cities; 
Podgorica, Montenegro; Changwon, Busan and Jeju City, Korea; Bishkek, 
Kyrgyzstan; Konak and Alsancak, Turkey; Almaty, Kazakhstan Konak 
and Alsancak, Turkey; Almaty, Kazakhstan; Cagayan de Oro City,  
Philippines; Busan and Jeju City, Korea.

COLLEGE & COMMUNITY CAMPAIGNS 

V-DAY IN ACTION

The experience was life changing. Words don’t really 
describe it, but it felt amazing to be a part of; to 
share the stories of The Vagina Monologues just felt 
so important to the cast and crew. It was an emotional 
roller coaster for us and the audience and it was  
a pleasure and a privilege to share such an open 
exchange between us as story tellers and the audience.

Campus Accountability Project
The Campus Accountability Project (CAP), since  
the 2009 launch, has steadily gained exposure and 
reached its submissions goal of 300 schools campus 
sexual assault response policies, which represents 
10% of the colleges and universities in the United 
States. With this cross-section we began work on 
the next phase of the project, collating a report on 
our findings. In January, SAFER spearheaded data- 
analysis which resulted in the finished report being 
released in September 2013. 

V-Spot
For the 2012-2013 season, we re-designed the 
V-Spot, V-Day’s activist website. Our goal was to 
maximize usability for our organizers and to create  
a codebase that would provide a more sustainable 
framework for future V-Day campaigns’ work online. 
We implemented a newer, more sophisticated form 
of geocoding to allow activists and V-Day staff to 
view and sort events and beneficiaries by geographical 
location. We also created new tools to help organizers 
plan, publicize, and execute their events and a 
beneficiary database of all the organizations that 
have collaborated with and received crucial funding 
from V-Day events. 

Sarah Homan,  
Wanganui New Zealand (organizer) 
The Vagina Monologues
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V-Girls
This year, V-Girls grew to include over 740 local 
groups called “Emotional Creature Clubs,” tripling 
the number of registered groups from 2011 to 2013. 
Girls are leading Emotional Creature Clubs in schools, 
after school groups, and youth organizations. A free 
downloadable V-Girls Action Guide is available 
online free of charge. The Guide integrates Emotional 
Creature for peer-to-peer sessions and in-classroom 
instruction and offers lesson plans and projects in 
Language Arts, Social Studies, Health, and Theatre. 
V-Girls around the world took a lead in One Billion 
Rising, dancing, organizing flash mobs, workshops, 
and task forces, and creating songs, poetry, dances 
and art. 

Four South Africa V-Girls - Mbali Khumalo, Ratanang 
Mogotsi, Karabo Tshikube and Samu Khumalo - who 
attended our Africa Summit were also able to visit 
Agnes Pareyio’s Tasaru Ntomonok Rescue Center in 
Narok, Kenya.  The girls led over 40 youth peers 
living at the Safe House in an Emotional Creature 
workshop.

Emotional Creature
Thanks to the generous support of our donors, the 
workshop productions of Emotional Creature in South 
Africa and Paris in 2011, the commercial premiere at 
the Berkeley Repertory Theatre in California in June 
2012, and the off-Broadway run at the Signature Center 
in New York in November 2012 were all a resounding 
success. Produced by V-Board members Carole Black 
and Pat Mitchell, and Associate Producer, V-Day’s 
Tony Montenieri, the NYC production opened to rave 
reviews providing a platform to reach young people 
through schools and youth organizations. Generous 
donations were made that provided free and reduced- 
cost tickets to students who would otherwise not be 
able to see the show, expanding the reach of V-Girls 
in these cities and allowing over 5,000 youth to see 
Emotional Creature. V-Girls created an interactive 
experience in the theatre with an Emotional Creature 
wall where audience members could post their 
reactions to the show. Additionally, post-show talk 
backs led by V-Girls leaders and cast members 
provided an opportunity for girls and girl advocates to 
gather after performances to discuss the show, share 
the V-Girls program, and talk about how Emotional 
Creature inspires activism in young and old alike.

V-Men
150 V-Men workshops took place around the world, tripling the amount 
we had last year. One Billion Rising certainly helped to engage men  
on a deeper level throughout the movement. In the Philippines, for 
example, a mass media campaign to engage men and boys to join  
One Billion Rising by a group of men chosen by female V-Day activists 
brought out many. The men chosen included a national artist of  
literature, a TV host, a congressman/activist, a farmer, a visual artist, a 
sports commentator, a singer-theatre actor, a film and TV actor, a theatre 
director, and a priest. Representing a broad spectrum of Filipino society, 
these men were crucial in engaging a large number of men and boys. 

In the Congo, the V-Men campaign is beginning to take hold with men 
joining from all sectors, doctors, teachers, policeman, the governor, 
and even men in the army.

Eve’s beautiful poem, The Man Prayer, inspired by a meeting with His 
Holiness Gyalwang Karmapa at TED India, was poignantly brought to 
life as a short film by Eve and filmmaker Tony Stroebel.

This is not a women’s issue – it’s  
a global crisis. Let’s work together  
to ensure that no more mothers, 
daughters, sisters, aunts, nieces,  
no more grandmothers experience 
violence.

Robert Redford

Thanks to the generous grants 
from the following V-Day supporters, 
over 5,000 youth saw Emotional 
Creature free of charge; Carole 
Black, Tena Clark, Beth Dozoretz, 
Eve Ensler, Jane Fonda, Novo 
Foundation, Mellody Hobson, 
Jurate Kazickas, Ken Lowe, 
Jacque Mayfield, Patricia 
Mitchel, Dawn Ostroff, Scott 
Seydel, and AOL.

Mbali Khumalo, V-Girls 
South Africa

[It] gave us the opportunity to laugh, dance and talk to 
one another. The girls told us that they travelled many 
miles to get to the Safe House, running away from the cut 
and towards a brighter future. It took SO much for me not 
to burst out crying when they shared their hopes and 
dreams with us. ‘I want to be a lawyer, I want to be a 
teacher, I want to write, I want to save my sisters!
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V-DAY’S CONGO CAMPAIGN

City of Joy
By July 2013, the City of Joy had graduated 222 
women! Women are leaving the City of Joy having 
had the opportunity to heal from their emotional 
wounds, live in community, recognize their leadership 
skills, and gain valuable skills they can apply to their 
lives, future business, and engagement in civic life.

On a cultural and political level, the City of Joy 
stands out as a unique example of a project that has 
its eye on the future of Congo. City of Joy provides a 
foundation for its women participants, and is an 
inspiring a new model of programming. It has also 
served as a physical hub for grassroots sensitization 
work, from which women participants have boldly 
advocated for themselves and their sisters in the 
press and in front of elected officials.

V-World Farm
The V-World farm, a partnership between V-Day and 
the 11th Hour Project, is a sustainable farm about an 
hour away from the City of Joy, which is partly 
serving as an added learning tool for the women at 
the program, reinforcing this feeling of forward thinking 
for Congolese women. A lush expanse of land with 
carrot, cassava, corn, tomato, soya, rice and bean 
crops, the grounds include Tilapia ponds and many 
pigs. V-Day’s plan is to develop the farm into a 
functioning and commercially successful model  
over the next 10 years, to be run by women survivors 
who will live there to form a farming cooperative. 
The cooperative will tend to the land and also train 
participants at the City of Joy in sustainable farming 
methods. 

Nothing is going to stop 
us. We have created 
something huge, we  
have a mission, we are 
empowering women to 
take the power in this 
country and we will  
continue.

Christine Schuler Deschryver, 
V-Day Congo  
Director/Director City of Joy 
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2014 - ONE BILLION RISING FOR JUSTICE 

Envisioning Justice
One Billion Rising For Justice was envisioned by 
international Regional Coordinators at a gathering  
in New York City in April 2013. The focus on justice 
stems from the systematic and endemic global 
impunity for perpetrators of violence against women 
and girls that is occurring on local, national, and 
international levels. A unanimous decision was made 
to focus on justice as an escalation of our demand to 
end violence against women and girls once and for all.

 
Global Coordinators
One Billion Rising Global Coordinators are activists 
based around the world who are engaging their  
communities, cities, countries, and regions to be a 
part of One Billion Rising For Justice. Many of these 
women and men coordinated efforts in 2013, and as 
long-time activists and V-Day organizers they have 

 

One Billion Rising For Justice is a call to women, men, and youth around the world to 
gather safely on 14 February 2014 outside places where they are entitled to justice – 
court houses, police stations, government offices, school administration buildings, work 
places, sites of environmental injustice, military courts, embassies, places of worship, 
homes, or simply public gathering places where women deserve to feel safe but too often 
do not. 

The campaign is a recognition that we cannot end violence against women without looking 
at the intersection of poverty, racism, war, the plunder of the environment, capitalism, 
imperialism, and patriarchy. Impunity lives at the heart of these interlocking forces. It is  
a call to survivors to dance across every country, break the silence, release their stories, 
acknowledge the truth in solidarity and community, and bring on revolutionary justice. 

Just like One Billion Rising in 2013, we want the world to see the power of global solidarity, 
transcending borders, class, age, race, culture, and gender.

On 14 February 2014, we are escalating our 
efforts to demand an end to violence against 
women and girls by ending the culture of  
impunity that keeps it in place. We are calling 
on women and men everywhere to RISE, RELEASE, 
DANCE, and demand JUSTICE!

the skills, networks, and ability to help guide local 
organizations, individuals, lawyers, unions, and 
alliances with their participation in the campaign. 
They will strategize, create, and promote One Billion 
Rising For Justice all over the world.

 
Global Coordinators Locations
Balkans: Albania, Bosnia & Herzegovina, Bulgaria, 
Cyprus, Greece, Romania, Former Yugoslavia • 
Central America: Costa Rica, El Salvador, Guatemala, 
Honduras, Nicaragua, Panama • European Union  
• Germany • Italy • Mexico • Pakistan • Philippines  
• Somalia • Sudan • South America: Argentina, 
Bolivia, Chile, Columbia, Ecuador, Paraguay, Peru, 
Venezuela • Southern Africa: Botswana, Lesotho, 
Malawi, Mozambique, Namibia, South Africa,  
Swaziland, Zambia, and Zimbabwe • South Asia: 
Afghanistan, Bhutan, Bangladesh, India, Maldives, 
Nepal, Sri Lanka • United Kingdom • USA: Atlanta, 
Los Angeles, New York, Santa Fe and San Francisco.
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State Of Female Justice
Inspired by V-Day’s “The State of Female America” 
event in 2012 – the One Billion Rising For Justice “State 
of Female Justice” panel discussions will premiere 
in New York City, with similar panels being held in 
various select countries around the world. The 
events will focus on discussions on social and 
feminist justice, and their relationship to ending 
violence against women.

World Tour
Starting in September 2013, Eve and One Billion 
Rising Director Monique Wilson will go on an  
international tour to raise awareness about the 
campaign, talk to women’s groups and grass roots 
communities, and connect with activists on the 
ground who are organizing One Billion Rising For 
Justice events.

World tour stops will include: Bali, France, Germany, 
Haiti, Hungary, India, Myanmar, Nepal, The Philip-
pines, Singapore, U.S., and UK. 

#CAMPUSRISING
V-Day’s legacy on college campuses has contributed 
to what is now a widespread dialogue about reforming 
campus sexual assault policies. As part of One 
Billion Rising for Justice, V-Day activists at colleges 
and universities will examine and expose injustices 
on their own campuses through the Campus Rising 
campaign.

This student-driven movement will work towards 
ending the prevalence of on-campus sexual assault 
and date-rape, as well as administrations’ failure to 
properly prevent or adequately respond to the needs 
of college survivors.

New Website
The new One Billion Rising For Justice website  
includes interactive user features, an international 
blog series on “Envisioning Justice,” creative  
expressions of justice through images, poetry, music, 
and film, a new toolkit for organizers and risers, links 
for our other social media sites like Twitter, Facebook, 
and Tumblr – all created to help risers around the 
world connect and be inspired by each other’s  
artistic initiatives.

New Short Film
V-Day has created a new short film featuring moving 
footage from Risings that took place around the 
world in 2013. Like the 2013 Short Film and “Man 
Prayer,” this new piece will help galvanize and 
activate people to RISE for justice. A longer version 
is being created showcasing the magnitude of One 
Billion Rising for broadcast on TV, Internet & movie 
theaters around the globe leading up to  
14 February, 2014.

Creative Justice
One Billion Rising For Justice is also a call to women 
and men around the world to create new, local 
artistic expressions of their visions of justice – from 
poetry to spoken and written word, to photography, film, 
music, and visual arts.

#rise4justice

#campusrising
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CORE

TEAM
Eve Ensler 
Founder/Artistic Director (Volunteer)

Joliz Cedeño 
Campaigns Manager

Carl Cheng 
Online & Creative Services Manager

Noelle Colomé 
Development Director

Purva Panday Cullman 
Programs & Giving Director

Kate Fisher 
Communications & Special Events Director

Cecile Lipworth 
Managing Director

Tony Montenieri 
Director of Operations

Shael Norris 
College & Community Campaigns Director

Christine Schuler Deschryver 
V-Day Congo Director & Director of City of Joy

Amy Squires 
Online Director

Susan Celia Swan 
Executive Director

Kristina Vigna 
Finance Manager

Laura Waleryszak 
College & Community Campaigns Manager

Monique Wilson  
One Billion Rising Director

V-Day thanks Heather Moseley, Megan Sparkman, 
David Hay, Nikki Noto, Jonathan Archer, Brooke 
Shelby Biggs, Jason Sywak, Jennifer Hirsch,  
Cathryn Swan and Emi Kane for their dedicated  
work and support.

Guiding Principal
V-Day will maintain the two synergistic realms that give V-Day its 
strength - its dedicated volunteer activists and its unique  
organizational model. Unlike most global NGOs, V-Day does not have 
central headquarters or regional offices. Instead, V-Day’s small group  
of 14 paid staff work remotely from home bases around the world to 
sustain an online infrastructure that keeps the V-Day network of activists 
(one billion strong and growing) linked, informed and engaged across 
the world. Through its virtual structure, V-Day is able to keep traditionally 
high overhead costs very low, enabling it to give away 89 cents of every 
dollar raised.  This intentional organizational arrangement allows V-Day 
to be viewed by its dedicated activists as a movement that is owned by 
them, on the grassroots level. Eve Ensler, V-Day’s Founder and Board 
Chair, is a volunteer and has never received payment from V-Day for 
her work.

Board of Directors 
The V-Day Board of Directors is a group of extraordinary women who 
provide vision, leadership, and wisdom to help guide and support  
V-Day in its work:

Carole  
Black

Sheryl  
Sandberg

Jennifer  
Buffett

Katherine  
McFate

Lisa  
Schejola Akin

Kimberlé  
W. Crenshaw

Pat  
Mitchell

Wendy  
Schmidt

Rosario  
Dawson

Thandie  
Newton

Regina  
K. Scully

Eve  
Ensler

Emily  
Scott Pottruck

Susan  
Celia Swan

Jane  
Fonda

Amy  
Rao

Charlize  
Theron

Mellody  
Hobson

Cari  
Ross

Kerry  
Washington
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FINANCIAL STATEMENt
for the fiscal year ending June 30th, 2013

INCOME	
Foundations 	 $	 3,040,556 
Individual Donors & Corporate Sponsors	 $	  2,288,411 
Donated Goods & Services 	 $	 110,000 
One Billing Rising Fund for Panzi Hospital (DRC)	 $	  410,800 
V-Day Campaign Spotlight Contributions 	 $	 248,744 
Interest Income 	 $	 3,974

Total Income	 $	 6,102,485 

			 

EXPENSES			

Programs			 
Community & College Campaign	 $	 246,377 
Communications & Events	 $	 428,599  
Website/V-Spot	 $	 234,607  
V-Girls	 $	 261,002  
One Billion Rising	 $	 1,700,103 

Total Programs	 $	 2,870,687 

Grants

Safe Houses, Haiti Spotlight, Vagina Warrior Scholarships & Emergency Aid 	 $	 1,163,471 
One Billing Rising Fund for Panzi Hospital (DRC) 	 $	 191,585 
City of Joy / V-World Farm (DRC) * 	 $	 1,087,247

Total Grants **	 $	 2,442,304 

Donated Goods & Services

Donated Goods & Services	 $	 110,000 

Total Programs, Grants & Donated Goods & Services	 $	 5,422,991 

Staff & Administration

Development	 $	 204,828  
Finance and Infrastructure	 $	 474,666 

Total Staff & Administration	 $	 679,494

Reserve Funds 			

Reserve Funds for 2012-2013 General Operating	 $	 250,000 

Total Expenses	 $	  6,102,485 

   *Grant includes 2012-2013 operating & campaign expenses for City of Joy.

** V-Day’s College & Community Campaigns raised an additional $2,381,486 million dollars in 2013 that V-Activists donated directly 
     to anti-violence groups in their communities

     Tens of thousands of talented volunteers dedicated their time to spreading the movement each and every day. Thanks to them,  
     the V-Day movement has spread across the planet, with kindness, energy and creativity.			 

One Billion Rising has activated the world! It has 
ignited and stirred our hearts and souls and given a 
voice for so many in support of humanity. It has 
reminded us that we are alive, and share in the 
responsibility of making our world a better place.  
One Billion Rising is not only a global movement - it  
is a moral imperative!

Regina K. Scully, V-Board Member
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THANK YOU

V-Day would like to thank every person who 
gave this past year, regardless of amount.   
The support of thousands of generous  
donors, and tens of thousands of talented 
volunteers worldwide makes V-Day’s work 
possible. The following foundations, individuals, 
and corporations provided extraordinary 
leadership gifts to support our work this 
year and dedicated their time to spreading 
the movement each and every day. Thanks 
to all of your generosity, the movement is 
alive and thriving and rising.

$2,000,000+
> NoVo Foundation

500,000+
> Regina K. Scully
> Anonymous

200,000+
> Emily & David Pottruck
> Amy Rao
> The 11th Hour Project
 
100,000+
> Susie Tompkins Buell  
	 & Mark Buell

50,000+
> Carole Black
> Kieschnick Family Fund
> Pat Mitchell
> The David and Lucile  
	 Packard Foundation
> Skees Family Foundation
> The Skoll Foundation
> Marsha Williams
> The MCJ Amelior  
	 Foundation
> Anonymous

20,000+
> Bethany Asplundh
> Diana de Vegh & One  
	 World Fund
> Barbara Jones
> Mindy Uhrlaub,  
	 The Fledgling Fund
> Ron & Cheryl Howard 
	 Family Foundation
> Inmaat Foundation
> Gina Maya
> Carlo & Micól Schejola 	 
	 Foundation
> Stephen Lewis Foundation
> Maxine Stern  
	 Charitable Fund
> Turner Foundation, Inc.
> Wallace Global Fund
> Deb Wetherby
> The Women of Congo
> Anonymous
> Anonymous  

10,000+
> Lisa Brown &  
	 Daniel Handler
> Chris Haddad
> Mellody Hobson
> The Isabel Allende  
	 Foundation
> Julie Kavner
> Khachaturian Foundation
> Jimmy Choo Foundation  
	 on behalf of Thandie Newton
> JaMel & Tom Perkins
> Colin & Ronit Plank
> Jeremy Pochman
> Nancy Schaub
> Lisa & Mathew Sonsini

 5,000+
> Blossom Hil Foundation
> Eliza Brown
> Fonda Family Foundation
> Aileen Getty
> Ann Kaplan
> Jurate Kazickas
> John Ladner
> Lakshmi Foundation
> The Future Hope Foundation
> Renee Linnell
> Lois McGuire
> Frances Pepper
> Nancy Rose
> Kerry Washington

2,500+
> Angie Allen & Enid Draluck,  
	 Full Circle Living
> Feldman Family Fund
> Dewayne & Pat Gallenberg
> Nonie Greene
> Susan Haas & Keith Patti
> Stephanie Halouma
> Erin Noble
> Niyama Yoga
> Dawn Ostroff
> The Pensky Family  
	 Foundation
> Scott Seydel
> Howard and Sharon Socol  
	 Family Foundation
> Tender Education and Arts
 

1,000+
> Lisa Ades
> Esther Ann Asch
> Jackie Asplundh
> Wendy Belkin & Linda Bryant
> Berger Family Foundation
> Kathryn Blanchard
> Danah Boyd
> Joan Brooks Baker &  
	 Margeaux Klein
> Brumberger Foundation
> Leslie Walker Burlock
> Karen Cashen
> Tena Clark
> Connie Codding
> Jesse Cool
> Virginia Coyle
> Margaret & Reid Dennis
> Dagmar Dolby
> Beth Dozoretz
> Laura Ellington
> John Eugene
> Silvia Faidutti
> Randi and Bob Fisher
> Pam Fleischaker
> Josi Fleishman
> Corine Frankland

> Christopher Garneau
> Lynne & Daniel Gelfman
> Georgetown Day School
> Grant Me the Wisdom  
	 Foundation
> Liz Helenchild
> Barbara Merlino Henry
> Ingrid & Edward Hills
> Dean Hood
> Irene Hsu
> J.D.M. Foundation
> Patricia Joanides
> Lisa Jones
> Randen Kane
> Shirley Klinghoffer
> Leslie Family Foundation
> Lindy Family Charity Fund
> Ken Lowe and Scripps  
	 Networks
> Mali Marinelli
> Jacquelyn Mayfield
> Margot McFedries
> Margaret Mermin
> Margaret Newell
> Northern Trust
> Peco Foundation
> Lorena Perez
> Penny Platnick
> Karen Poltis-Virk

> Chelsie Prince
> Jana & Kee Reynolds
> Stacey Rhodes
> Susan Bell Richard
> Lisa Sardegna
> J. H. Singer
> Joseph & Diane Steinberg
> Jefferson Stone and  
	 Shannon Turk-Stone
> Karen Stone
> A.L. Swartzberg
> Phyllis Taylor
> Tompkins-Imhoff Fund
> Trustees of Boston Univerity
> Alan Farago & Lisa Versaci
> Adrian Villaraos
> K. Vojack
> W.S. Scharff Family  
	 Foundation
> Summer Tompkins Walker
> Yen Chuang Foundation
> Mark & Stacey Zolan
> Anonymous
> Anonymous

Corporate
> ABC Home & Planet  
	 Foundation
> Amanda Keidan Jewelry
> Atlantic Philanthropies
> Baker Creek Heirloom  
	 Seed Company
> Chavez For Charity
> Dramatists Play Service
> Horizon Media, Inc
> Joyaux Marisol
> MacMillan Publishers
> Mark Goucher Ltd
> MULU, Inc.
> Neiman Marcus
> Vosges Haut-Chocolat

VERY SPECIAL THANKS 
We extend our heartfelt 
thanks to the following  
individuals who so generously 
provided their pro-bono legal 
guidance: Janet Abrams, 
Janet Dubrovolny, and Nancy 
Rose. And to Paula Allen, 
Taylor Krauss, Tony Stroebel 
& Jo Stroebel/Redletter  
Productions and V-Day activists 
all over the world whose 
stunning images tell the story 
of V-Day on these pages.

Mobilizing my city for One Billion 
Rising was emotional and fulfilling.  
Miami ROSE in true tropical style 
under the stars and purifying rain. We 
engaged, educated, and celebrated 
our community through dance, music 
and art touching the hearts of adults 
and children and joining one billion 
people globally to make violence 
against women a thing of the past!

Lisa Schejola Akin, V-Board Member

Global Green USA facilitated a relationship with Sunpower Foundation to provide solar 
equipment to City of Joy, providing clean, reliable electricity.  In August, Matt Petersen  
(then GG President & CEO) traveled to Bukavu with a team of volunteers including Chadi 
Depelchin, Michael Stangl, & Heiko Steiber, to install the system and train a local team  
to operate and maintain it.
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#Rise4Justice! 14 February, 2014
Visit onebillionrising.org to:

REGISTER your event on the One Billion Rising For 
Justice map 
WATCH “This is What Justice Looks Like” videos 
SHARE “What Justice Looks Like” to you via video, 
words, song, art, or poetry 
MEET New Global Coordinators 
CONNECT with activists all over the world

 
ATTEND A V-DAY EVENT
Find a local benefit production near you and help 
raise money for groups working in your area to end 
violence against women and girls.

vday.org/events

ORGANIZE A V-DAY EVENT
Every year V-Day benefit productions take place in 
thousands of locations around the world. These 
events are organized by local college students and 
community activists – people just like you!

vday.org/organize  

TAKE ACTION

HELP TURN PAIN TO POWER  
IN CONGO
Visit vday.org/drc to:

EDUCATE yourself and others 
SUPPORT women on the ground 
DONATE to the campaign and City of Joy 
SIGN UP to host a Congo Teach-In 
VIEW photo galleries and videos

 
DONATE TO V-DAY
ONLINE at vday.org/donate 
TEXT VDAY to 50555 to donate $10 to V-Day 
MAIL checks to:

V-Day 
303 Park Ave South, Suite # 1184 
New York, NY 10010-3657 USA 
Make checks payable to “V-Day”

 
GET THE LATEST V-NEWS AS IT  
HAPPENS & SHARE IT WIDELY:
Get news of actions, opportunities, and performances. 
Get the latest messaged from Eve, Get involved and 
stay involved.

vday.org/vmail

Facebook.com/vday @vdayorg @vday 
@emocreature 
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WOMEN in one day.

ONE BILLION DANCED UP

END
THE will of the WORLD
TO VIOLENCE AGAI

NS
T

JUST IMAGINE WHAT WE’LL DO NEXT.

www.onebillionrising.org


